e2 studio 3.0.0.22 Release Note: 28th April 2014

Supported devices for project generation and debugging:

CcPU Family Devices
RH850 F1L R7F701002xAFP,R7F701010xAFP,R7F701013xAFP,R7F701018XAFP,R7F701023xAFP,R7F701025xAFP,R7F701031xAFP,R7F701035XAFP
DIA R5F10CGB,R5F10CGC,R5F10CGD,R5F10CLD,R5F10CMD,R5F10CME,R5F10DGC,R5F10DGD,R5F10DGE, R5F10DLD,R5F10DLE, RSF10DMD,R5F10DME,RSF10DMF,
R5F10DMG,R5F10DMJ,R5F10DPE,R5F10DPF,R5F10DPG,R5F10DPJ,R5F10TPJ
F12 R5F10968,R5F1096A,R5F1096B,R5F1096C,R5F1096D,R5F1096E,R5F109AA, R5F109AB,R5F109AC,R5F109AD,R5F109AE, R5F109BA,R5F109BB,R5F109BC,
R5F109B,,R5F109BE,RS5F109GA,R5F109GB,R5F109GC,R5F109GD,R5F109GE, RS5F109LA,R5F109LB,R5F109LC,R5F109LD,R5F109LE
R5F10A6A,R5F10A6C,R5F10A6D,R5F10A6E,RSF10AAA, R5F10AAC,R5F10AAD,R5F10AAE, R5F10ABA,R5F10ABC,R5F10ABD,R5F10ABE, R5F10AGA,R5F10AGC,
F13 R5F10AGD,R5F10AGE,R5F10AGF,R5F10AGG,R5F10ALC,R5F10ALD,R5F10ALE, R5F10ALF,R5F10ALG,R5F10AME, R5F10AMF,R5F10AMG, R5F10BAC,R5F10BAD,
R5F10BAE,R5F10BAF,R5F10BAG,R5F10BBC,R5F10BBD,R5F10BBE,R5F10BBF,R5F10BBG,R5F10BGC,R5F10BGD,R5F10BGE,R5F10BGF,R5F10BGG,R5F10BLC,
R5F10BLD,R5F10BLE,RS5F10BLF,R5F10BLG,R5F10BME,RSF10BMF,R5F10BMG
F14 R5F10PAD,R5F10PAE,R5F10PBD,R5F10PBE,R5F10PGD,R5F10PGE,R5F10PGF,R5F10PGG,R5F10PGH,R5F10PGJ,R5F10PLE, R5F10PLF,R5F10PLG,R5F10PLH,
R5F10PLJ,R5F10PME,R5F10PMF,R5F10PMG,R5F10PMH,R5F10PMJ,R5F10PPE,R5F10PPF,R5F10PPG,R5F10PPH,R5F10PPJ
G10 R5F10Y17,R5F10Y44,R5F10Y46,R5F10Y47
G12 R5F10266,R5F10267,R5F10268,R5F10269,R5F1026A,R5F10277,R5F10278,R5F10279,R5F1027A,R5F102A7,R5F102A8,R5F102A9, R5F102AA,R5F10366,
R5F10367,R5F10368,R5F10369,R5F1036A,R5F10377,R5F10378,R5F10379,R5F1037A,R5F103A7, R5F103A8,R5F103A9,R5F103AA
R5F1006A,R5F1006C,R5F1006D,R5F1006E,R5F1007A,R5F1007C,R5F1007D,R5F1007E,R5F1008A,R5F1008C,R5F1008D,R5F1008E,RSF100AA,RSF100AC,
R5F100AD,R5F100AE,R5F100AF,R5F100AG,R5F100BA,R5F100BC,R5F100BD,R5F100BE,R5F100BF,R5F100BG,R5F100CA,R5F100CC,R5F100CD,R5F100CE,
R5F100CF,R5F100CG,R5F100EA,RS5F100EC,R5F100ED,R5F100EE,R5F100EF,R5F100EG,R5F100EH,R5F100FA,R5F100FC,R5F100FD,R5F100FE, RSF100FF,
R5F100FG,R5F100FH,R5F100FJ,R5F100FK,R5F100FL,R5F100GA,R5F100GC,R5F100GD,R5F100GE, R5F100GF,R5F100GG,R5F100GH,R5F100GJ,R5F100GK,
R5F100GL,R5F100JC,R5F100JD,R5F100JE,R5F100JF,R5F100JG,R5F100JH,R5F1003J,R5F100JK,R5F100JL,R5F100LC,RS5F100LD,R5F100LE,RSF100LF,
R5F100LG,R5F100LH,R5F100LJ,R5F100LK,R5F100LL,R5F100MF,R5F100MG,R5F100MH,R5F100MJ,R5F100MK,R5F100ML,R5F100PF,R5F100PG,R5F100PH,
G13 R5F100PJ,R5F100PK,R5F100PL,R5F100SH,R5F100SJ,R5F100SK,R5F100SL,R5F1016A,R5F1016C,R5F1016D,R5F1016E,R5F1017A,R5F1017C,R5F1017D,
R5F1017E,R5F1018A,R5F1018C,R5F1018D,R5F1018E,R5F101AA R5F101AC,R5F101AD,R5F101AE, R5F101AF,R5F101AG,R5F101BA,R5F101BC,R5F101BD,
R5F101BE,R5F101BF,R5F101BG,R5F101CA,R5F101CC,R5F101CD,R5F101CE,R5F101CF,R5F101CG,R5F101EA,RSF101EC,RS5F101ED,R5F101EE, R5F101EF,
RL78 R5F101EG,R5F101EH,R5F101FA,R5F101FC,R5F101FD,R5F101FE, R5F101FF,RSF101FG,R5F101FH,R5F101FJ,R5F101FK,R5F101FL,R5F101GA,R5F101GC,
R5F101GD,R5F101GE,R5F101GF,R5F101GG,R5F101GH,R5F101GJ,R5F101GK,R5F101GL,R5F101JC,R5F101JD,R5F101JE,R5F101JF,R5F101JG,R5F101JH,
R5F101JJ,R5F101JK,R5F101JL,R5F101LC,R5F101LD,R5F101LE,R5F101LF,R5F101LG,R5F101LH,R5F101LJ,R5F101LK,R5F101LL,R5F101MF,R5F101IMG,
R5F101MH,R5F101MJ,R5F101MK,R5F101ML,R5F101PF,R5F101PG,R5F101PH,R5F101PJ,R5F101PK,R5F101PL,R5F101SH,R5F101SJ,R5F101SK,R5F101SL
R5F104AA R5F104AC,R5F104AD,R5F104AE,R5F104AF,R5F104AG,R5F104BA,R5F104BC,R5F104BD,R5F104BE, R5F104BF,R5F104BG,R5F104CA , R5F104CC,
R5F104CD,R5F104CE,R5F104CF,R5F104CG,R5F104EA, R5F104EC,R5F104ED,R5F104EE,R5F104EF, R5F104EG,R5F104EH,R5F104FA, R5F104FC,R5F104FD,
Gl4 R5F104FE,R5F104FF,R5F104FG,R5F104FH,R5F104FJ),R5F104GA R5F104GC,R5F104GD,R5F104GE,R5F104GF,R5F104GG,R5F104GH,R5F104GJ,R5F104JC,
R5F104JD,R5F104JE,R5F104JF,R5F104JG,R5F104JH,R5F1041J,R5F104LC,R5F104LD,R5F104LE, R5F104LF,R5F104LG,R5F104LH,R5F104L), R5F104MF,
R5F104MG,R5F104MH,R5F104MJ,R5F104PF,R5F104PG,R5F104PH,R5F104PJ
G1A R5F10E8A,R5F10E8C,R5F10E8D,R5F10E8E,RSF10EBA,R5F10EBC,R5F10EBD,R5F10EBE ,R5F10EGA,R5F10EGC, R5F10EGD,R5F10EGE, R5F10ELC,R5F10ELD,RSF10ELE
G1C R5F10JBC,R5F10JGC,R5F10KBC,R5F10KGC
GI1E R5F10FLC,R5F10FLD,R5F10FLE,R5F10FMC,R5F10FMD,R5F10FME
11A R5F1076C,R5F107AC,R5F107AE,R5F107BC,R5F107DE
11B R5F10MME,R5F10MMG,R5F10MPE,RSF10MPG
L12 R5F10RB8,R5F10RBA,R5F10RBC,R5F10RF8,R5F10RFA,R5F10RFC,R5F10RG8,R5F10RGA,R5F10RGC,R5F10RJ8,R5F10RJA,RSF10RIC,R5F10RLA,RSF10RLC
L13 R5F10WLA,R5F10WLC,R5F10WLD,R5F10WLE,R5F10WLF,R5F10WLG,R5F10WMA,R5F10WMC,R5F10WMD,R5F10WME,R5F10WMF,R5F10WMG
R5F110NE,R5F110NF,R5F110NG,R5F110NH,R5F110NJ,R5F111INE,R5F111NF,R5F111ING,R5F111NH,R5F111NJ,R5F110ME,R5F110MF,R5F110MG,R5F110MH,
Lic R5F110MJ,R5F110PE,R5F110PF,R5F110PG,R5F110PH,R5F110PJ,R5F111ME,R5F111MF,R5F111MG,R5F111MH,R5F111MJ,R5F111PE,R5F111PF,R5F111PG,
R5F111PH,R5F111PJ
110 R5F51101,R5F51103,R5F51104,R5F51105,R5F5110H,R5F5110J,
111 R5F51111,R5F51113,R5F51114,R5F51115,R5F5111)
210 R5F52103,R5F52104,R5F52105,R5F52106,R5F52107,R5F52108, R5F5210A,R5F5210B
21A R5F521A6,R5F521A7,R5F521A8
220 R5F52201,R5F52203,R5F52205,R5F52206
610 R5F56104,R5F56106,R5F56107,R5F56108
621 R5F56216,R5F56217,R5F56218
62G R5F562G7,R5F562GA
RX 62N R5F562N7,REF562N8
62T R5F562T6,R5F562T7,R5F562TA
630 R5F56307,R5F56308,R5F5630A,R5F5630B,R5F5630D,R5F5630E
R5F56316,R5F56317,R5F56318,R5F5631A,R5F5631B,R5F5631D,R5F5631E,R5F5631F, R5F5631G,R5F5631], R5F5631K,R5F5631M,R5F5631N,R5F5631P, R5F5631W,
631 R5F5631Y,R5S56310,
R5F5631MF,R5F5631PF (Debug Support Only)
63N R5F563NA,RS5F563NB,R5F563ND,R5FS563NE,RSFS63NF,RSF563NK,RSF563NW,R5FS63NY
63T R5F563T4,R5F563T5,R5F563T6,R5F563TB,R5F563TC,R5F563TE
R5F563TB_5V,R5F563TC_5V,R5F563TE_5V (Debug Support Only)
64M R5F564MF,R5F564MG,R5F564MJ,R5F564ML
RZ RZ-A R7S72100,R7S72101,R7S72102
SH2A SH7201,SH7203,SH72165AD,SH72546RFCC,SH72611,SH72620,SH72630,SH72640,SH72690,SH7670,
SH2 SH7047F,SH70834A,SH70844A,SH70854A,SH70865A,SH71242,SH71252,SH7144F SH7145F, SH71464A,SH71491R,SH7615,SH7616,SH7618,SH7619,

SH2a (No FPU)

SH7206,SH7211,SH7243,SH7285,SH7286,




SH

Other

CUSTOM_DEVICE_1,SH-2A_C_1C3A_3,SH-2A_C_1C3A_4,SH-2A_C_1C3A_5,SH-2A_C_1C3A_6,
SH-2A_C_1C3A_F, SH_CUSTOM_MCU,SH2A_CUSTOM_MCU1,
SH2A_CUSTOM_SOC_1,SH2A_CUSTOM_SOC_2,SH2A_CUSTOM_SOC_3,SH2A_CUSTOM_SOC_4,SH2A_CUSTOM_SOC_5,

SH70835A,SH70835R, SH70845A, SH70845R, SH70855A, SH70855R, SH70865R, SH71243,SH71253,SH71464R, SH71494A,SH71494R, SH7214,SH72145AD,
SH72145BD,SH72146AD,SH72146BD,SH72147AD,SH72147BD,SH7215,SH721658D,SH72166AD, SH72166BD,SH72167AD,SH72167AD_Option,SH72167BD,
SH72265,SH72266,SH72267,SH72275,SH72276,SH72277,SH72314L, SH72315A, SH72315L, SH72374A,SH72374B,SH723758,SH72394A, SH72394B, SH72395A,
SH72395B,SH72531,SH72531FCC,SH72531RFCC, SH72533,SH72533FCC,SH72543R, SH72544R, SH72546R,SH72612,SH7261_FPULess,SH72621,SH72622,
SH72623,SH72624,SH72625,SH72626,SH72627,SH72631,SH72632,SH72633,SH72641,SH72642,SH72643,SH72644,H72645,SH72646, SH72647,SH72660,
SH72661,5H72662,SH72663,5H72670,SH72671,SH72672,SH72673

SH72680,SH72681,SH72691,5H7606,SH7618A,SH7671,SH7672,SH7673, (Debug Support Only)

Integrated Code Generator Supported Devices:

CPU Family Devices

G10 R5F10Y14,R5F10Y16,

G12 R5F10266,R5F10267,R5F10268,R5F10269,R5F1026A,R5F10277,R5F10278,R5F10279,R5F1027A, R5F102A7,R5F102A8,R5F102A9,R5F102AA,R5F10366,R5F10367,R5F10368,
R5F10369,R5F1036A,R5F10377,R5F10378,R5F10379,R5F1037A,R5F103A7,R5F103A8,R5F103A9,R5F103AA,
R5F1006A,R5F1006C,R5F1006D,R5F1006E,R5F1007A,R5F1007C,R5F1007D,R5F1007E,R5F1008A,R5F1008C,R5F1008D,R5F1008E,R5F100AA, R5F100AC,R5F100AD,R5F10
OAE,R5F100AF,R5F100AG,R5F100BA,R5F100BC,R5F100BD,R5F100BE,R5F100BF,R5F100BG,R5F100CA,R5F100CC,R5F100CD,R5F100CE,R5F100CF,R5F100CG,R5F100E
A,R5F100EC,R5F100ED,R5F100EE,R5F100EF,R5F100EG,R5F100EH,R5F100FA,R5F100FC,R5F100FD,R5F100FE,R5F100FF,R5F100FG,R5F100FH,R5F100FJ,R5F100FK,R5
F100FL,R5F100GA,R5F100GC,R5F100GD,R5F100GE,R5F100GF,R5F100GG,R5F100GH,R5F100GJ,R5F100GK,R5F100GL,R5F100JC,R5F100JD,R5F100JE,R5F100JF,R5F10
0JG,R5F100JH,R5F100JJ,R5F100JK,R5F100JL,R5F100LC,R5F100LD,R5F100LE,R5F100LF,R5F100LG,R5F100LH,R5F100L],R5F100LK,R5F100LL,R5F100MF,R5F100MG,R5

G13 F100MH,R5F100MJ,R5F100MK,R5F100ML,R5F100PF,R5F100PG,R5F100PH,R5F100PJ,R5F100PK,R5F100PL,R5F100SH,R5F100SJ,R5F100SK,R5F100SL,R5F1016A,R5F101
6C,R5F1016D,R5F1016E,R5F1017A,R5F1017C,R5F1017D,R5F1017E,R5F1018A,R5F1018C,R5F1018D,R5F1018E,R5F101AA, R5F101AC,R5F101AD,R5F101AE, R5F101AF, RS
F101AG,R5F101BA,R5F101BC,R5F101BD,R5F101BE,R5F101BF,R5F101BG,R5F101CA,R5F101CC,R5F101CD,R5F101CE, R5F101CF,R5F101CG,R5F101EA,R5F101EC,R5F1
01ED,R5F101EE,R5F101EF,R5F101EG,R5F101EH,R5F101FA,R5F101FC,R5F101FD,R5F101FE,R5F101FF, R5F101FG,R5F101FH,R5F101FJ,R5F101FK,R5F101FL, R5F101GA
,R5F101GC,R5F101GD,R5F101GE,R5F101GF,R5F101GG,R5F101GH,R5F101GJ,R5F101GK,R5F101GL,R5F101JC,R5F101JD,R5F101JE,R5F101JF,R5F101JG,R5F101JH,R5F
101JJ,R5F101JK,R5F101JL,R5F101LC,R5F101LD,R5F101LE,R5F101LF,R5F101LG,R5F101LH,R5F101LJ,R5F101LK,R5F101LL R5F101MF,R5F101MG,R5F101MH,R5F101MJ,
R5F101MK,R5F101ML,R5F101PF,R5F101PG,R5F101PH,R5F101PJ,R5F101PK,R5F101PL,R5F101SH,R5F101SJ,R5F101SK,R5F101SL.

R5F104AA R5F104AC,R5F104AD,R5F104AE,R5F104AF,R5F104AG,R5F104BA,R5F104BC,R5F104BD,R5F104BE, R5F104BF,R5F104BG,R5F104CA R5F104CC,R5F104CD,R5
F104CE,R5F104CF,R5F104CG,R5F104EA R5F104EC,R5F104ED,R5F104EE,R5F104EF, R5F104EG,R5F104EH,R5F104FA, R5F104FC,R5F104FD,R5F104FE, R5F104FF,R5F10

Gl14 4FG,R5F104FH,R5F104FJ,R5F104GA,R5F104GC,R5F104GD,R5F104GE,R5F104GF,R5F104GG,R5F104GH,R5F104GJ,R5F104JC,R5F104JD,R5F104JE,R5F104JF, R5F104JG,
R5F104JH,R5F104J1,R5F104LC,R5F104LD,R5F104LE, R5F104LF,R5F104LG,R5F104LH,R5F104LJ,R5F104MF,R5F104MG,R5F104MH,R5F104MJ,R5F104PF, R5F104PG,R5F 1
04PH,R5F104PJ

RL78 G1A R5F10E8A RSF10E8C,RSF10E8D,RSF10ESE, RSF10EBA, RSF10EBC,RSF10EBD, RSF10EBE, RSF10EGA,RSF10EGC,RSF10EGD, RSF10EGE, RSF10ELC,R5F10ELD,RSF10ELE

GlC R5F10JBC,R5F10JGC,R5F10KBC,R5F10KGC

GI1E R5F10FLC,R5F10FLD,R5F10FLE,R5F10FMC,R5F10FMD,R5F10FME

11A R5F1076C,R5F107AC,R5F107AE,R5F107BC,R5F107DE

11B R5F10MME,R5F10MMG,R5F10MPE,RS5F10MPG

L12 R5F10RB8,R5F10RBA,R5F10RBC,R5F10RF8,R5F10RFA,R5F10RFC,R5F10RG8,R5F10RGA,R5F10RGC,R5F10RJ8,R5F10RJA,R5F10RIC,R5F10RLA,RSF10RLC
L13 R5F10WLA,R5F10WLC,R5F10WLD,R5F10WLE,R5F10WLF,R5F10WLG,R5F10WMA,R5F10WMC,R5F10WMD,R5F10WME,R5F10WMF,R5F10WMG

Lic R5F110ME,R5F110MF,R5F110MG,R5F110MH,R5F110MJ,R5F110PE,R5F110PF,R5F110PG,R5F110PH,R5F110PJ,R5F111ME, R5F111MF,R5F111MG,R5F111MH,R5F111MJ,R
5F111PE,R5F111PF,R5F111PG,R5F111PH,R5F111PJ

F12 R5F10968,R5F1096A,R5F1096B,R5F1096C,R5F1096D,R5F1096E,R5F109AA, R5F109AB,R5F109AC,R5F109AD, R5F109AE,R5F109BA,R5F109BB,R5F109BC,R5F109BD,R5F1
09BE,R5F109GA,R5F109GB,R5F109GC,R5F109GD,R5F109GE, R5F109LA,R5F109LB,R5F109LC,R5F109LD,R5F109LE

F14 R5F10PAD,R5F10PAE,R5F10PBD,R5F10PBE,R5F10PGD,R5F10PGE, R5F10PGF,R5F10PGG,R5F10PGH,R5F10PGJ,R5F10PLE, R5F10PLF,R5F10PLG,R5F10PLH,R5F10PLY,
R5F10PME,R5F10PMF,R5F10PMG,R5F10PMH,R5F10PMJ,R5F10PPE,R5F10PPF,R5F10PPG,R5F10PPH,R5F10PPJ,
R5F10A6A,R5F10A6C,R5F10A6D,R5F10A6E,RSF10AAA, RSF10AAC,R5F10AAD,R5F10AAE, R5F10ABA,R5F10ABC,R5F10ABD,R5F10ABE, RSF10AGA, R5F10AGC,R5F10AGD

F13 ,R5F10AGE,R5F10AGF,R5F10AGG,R5F10ALC,R5F10ALD,R5F10ALE,R5F10ALF,R5F10ALG,R5F10AME, R5F10AMF,R5F10AMG,R5F10BAC,R5F10BAD,R5F10BAE,R5F10BA
F,R5F10BAG,R5F10BBC,R5F10BBD,R5F10BBE,R5F10BBF,R5F10BBG,R5F10BGC,R5F10BGD,R5F10BGE,R5F10BGF,R5F10BGG,R5F10BLC,R5F10BLD,R5F10BLE,R5F10B
LF,R5F10BLG,R5F10BME,R5F10BMF,R5F10BMG

RX 111 R5F51111,R5F51113,R5F51114,R5F51115,R5F5111J
RX 110 R5F51101,R5F51103,R5F51104,R5F51105,R5F5110H,R5F5110J




New features in 3.0:

Component Description
Application Previous version of e2 studio was based on the Juno Eclipse version. This update moves the Eclipse version to Kepler SR1.
Application CDT component updated to 8.3. For an update on what is new in 8.3 of CDT please check this:
PP http://wiki.eclipse.org/CDT/User/NewIn83
Various updates made to the previous CDT integration to improve application functionality.
- Project generation when using a folder that contains multi-byte characters is now fixed.
- When an error occurs in the linker and the user fixes it and rebuilds it is now removed from the problems tab.
- Build console error and warnings are colour coded and you can also jump to the relevant source window when double clicked.
P A —
e
0 reioc -0
NE—
i
wite
i
" 2= Benchenellalct EaR 20 il
Application . =
B @m (Do k(@R B B @ o
.
T ————
e
inhet s srd betiding: . arefesss rog-m. -
“ririohe samning s buileing: - faeentarrapanelers.<t
R
n == m J o
- Elapsed build time is displayed in the build console.
+ The disassembly window now correctly shows Opcodes.
The included memory plugin with CDT has been enhanced. The following improvements have been made:
- When terminating the debugger the setup of the current renderings are stored in the current debugger configuration.
- The memory renderings are automatically opened when the debugger connection is restored and the memory plugin is open.
+ Adding memory monitors with symbol support is improved.
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- Memory fill made more prominent.
- Improved memory import performance from the memory plugin.
'Waveform memory rendering added to memory plugin.
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HEW workspace import is now supported.

&7 HEW Import ) [

Import HEW Project(s)
Browse HEW project file (hwp) / workspace file Ghws)

HEW wersians lawer than w407 are not officially supported

Only Compiler, &ssernbler, Linker and Library Generatar phase settings will be imported
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- Open project in HEW IDE

- Save the HEW Warkspace : File > Save Warkspace

- Importin €2 studio IDE
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RX RX64M is supported.
Improvements made to RH850:
RH850 - RH850 debugging also now supports the profile view.
- The RH850 GDB now supports Python scripting correctly.
RL78 On-chip trace now supported for RL78/F13 and F14.
RL78 RL78 EZ Emulator supported.
Multiple download module support added.
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Stack Analysis plugin added. (Similar to Call Walker in HEW/CubeSuite+)
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Debugger status Further modes added to the MCU display status control in the status bar.
Custom phases support similar to that seen in HEW. Supported types in this version are:
Application 1. A custom tool (e.g. “yacc”) might be used to generate C/C++/Asm source code for subsequent compilation by existing tools.

2. A custom tool (e.g. "lint") might be used immediately prior to building a C/C++/Asm file to invoke an informational tool.

Real-time chart

Improved real-time chart.

Builder

Manual dependency scanning options added to the builder to improve overall build time when dependencies are known to be not changing.

CCRX Build plugin

Renesas CCRX 2.01.00 toolchain support.
CCRX toolchain and global optimization option support.




Application Improved method of downloading and supplying smart manuals.
Improved installer capable of deploying Renesas plugins to a generic Eclipse.
Installer Requirements are as follows: Eclipse base version needs to be Kepler.
The installer cannot use Helios or Juno Eclipse versions.
Application CCRX e2 studio project conversion to e2 studio GCC projects.

e2 studio integration service

Improved e2 studio integration service.

- Add an include path to the build options of the toolchain in a project/build configuration pair.

- Add a library or archive file to the build options of the toolchain in a project/build configuration pair.

- Open a project that is currently closed in the workspace.

- Set and clear standard Eclipse breakpoints at a source line or address.

- Implement the ability to control debug execution more precisely using the step commands.

- Events for resume and suspend of the debugger will be support to avoid the use of polling in the calling application.

Visual Expressions

Additional controls added to the Visual Expressions plugin. Including meter, vertical slider, horizontal slider and thermometer.

RX Debug Configuration

RX Hot Plug support

Code Generator

Improved code generator support for more devices along with Pin View support.
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Important workarounds useful to know when using 3.0:

ID Component Description
If you are experiencing slow building of projects within e2 studio there are some possibilities to improve.
The system environment will attempt to find the make.exe tool via the system environment. If you ensure the directory make resides in is at the start of the path variable it will find it
NA Application more quickly. Especially important if there are network drives in the path.
In the project properties, C/C++ Build tab, behaviour tab you can switch on parallel build. This will take advantage of the multi-cores on your host machine if it has them.
In 2.1 or later this now defaults to on for new projects.
NA GCC Build Plugi The GNU toolchain linker file format has changed in 3.0. This means projects that are developed in 3.0 and opened in 2.x will still continue to build. However you may experience
ul ugin issues visiting the GCC Linker Sections user interface.
Code Generator can delete user code between /* Start */ End comments in some situations.
Using the code generator if the following code is placed in the main function:
5041 Code generator /fif(data_in! =0xAA){
on a line by itself, all of the main code will be removed when Generate Code button is pressed.
The key issue is that the { brace is on the same line as the comment.
5016 Project G ti When initially creating a debug only project the extension of the specified module is not added to the debug configuration dialog. This means the file cannot be found when launched.
roject Generation Adding the extension back manually rectifies the problem.
Symptoms: Project fails to build after import from HEW
2010 HEW Importer Conditions: If a long filename or path is used, and the HEW project importer is used, the project may fail to build.
Workaround: Move the original HEW project to a shallow directory structure (i.e.) C:\Workspace and import from there. Also ensure that the HEW project is relocated before
importing into e2 studio.
Debug configurations have been modified in €2 studio 2.x. So although you can re-use the workspace and projects from e2 studio 1.x when you open the debug launch configuration
I for the first time it is updated.
2421 Application
Before doing this you should back-up the .launch file if you need to keep a 1.x version.
NA Application It is not possible to import e2 studio 1.x projects which are for the V850 device into e2 studio 2.0.




Symptoms: Project fails to build in first instance after archive project import (not from HEW)
1922 Application Conditions: If an archived project is imported it may fail to build the first time, due to a residual .d file.
Workaround: Clean and Build a second time.
When using assembly code within a C source file, Codan errors can be observed in the editor. Even though the project builds successfully.
2762 Application
We do not have a workaround for this at this time.
Step into does not always work when using the CCRX 1.02.01 toolchain.
2728 GDB
To ensure this behaves correctly you will need to use CCRX 2.00.00 or greater as this issue with the debug information is corrected in this release.
NA Eventpoint If eventpoints do not always work just after they are set, you can use the "Apply to Target" toolbar button in the Eventpoint view to send the Eventpoints to the target manually. This will
ventpoints always ensure the debugger target has all the required eventpoint updates before execution starts.
Fixed issues in 3.0.0.22
1D Component Description
Wrench is not displayed after a file's build settings are modified.
2278 Application This is a generic CDT issue.
If you delete a src folder and add it again with the same name it gets excluded from the build.
2440 Application Click on the project and examine the source directories to add it back in.
2504 CCRX Build plugin When source files have timestamps ahead of the current time the project will compile every time until the file dates are passed.
2576 GDB Using RPBRL78L12 and GNURL78 v13.01,attempting to step into a C function call within an assembly file (reset_program.asm) results in a step over.
2755 Event points plugin Timer Value for Performance Start/Stop Eventpoints not being persisted.
2930 GDB server It is not possible to power the RH850 board via the E1 debugger in the current release.
When debugging an IAR RX project you may get an error rebuilding your project while debugging. As a workaround if you press “reload" before rebuilding, your project will be re-built
2963 GDB and the new binary reloaded into gdb after the build.
3017 CDT The "Show Opcodes" feature within the Disassembly window does not work correctly. This affects all targets.
3059 Register plugin The Find feature of the registers view does not work.
When using trace and the RH850 debugger when using the Disassembly view and Instruction Stepping Mode" a single step is performed.
3061 Application Some additional commands relating to the debugger were included in the trace output. Only the instruction "add r15, r1" should only be displayed.
3179 Application The setting of the Performance Analysis dialog is not saved.
3207 CCRX Build plugin When using the Renesas C compiler (CCRX) C source files cannot be compiled as C++ files.
When using an external build system to build a project, the Image Reload notification is not displayed when the image file is modified. This reload notification is only launched for the
3331 Application internal build procedure.
3450 Application Select all and copying the registers to the clipboard does not work correctly. This is also the case in the generic version of Eclipse Juno.
3476 Application When finding registers in the 10 view the result of the search is not highlighted but the view is scrolled.
3662 Application The selection and copying of all variables to the clipboard does not work in €2 studio. It also does not work in Eclipse Juno.
3788 Application RL78 Stack pointer register cannot be changed from registers view.
3832 Code Generator plugin Building an example using the code generator and selecting the "Generate hardware setup” in C caused the project to not build as the file iodefine.h is missing.
3841 Application When setting MBS > Compiler > Optimize >Advanced, option 'inter-module’ for 'Optimization for access to external variables' it causes a re-build every time.
When modifying the PC on RL78 when leaving the register in the format OxFF <main+xx> it fails.
3860 GDB If you remove the <main+xx> and just pass through a valid hex string it works fine.
3909 CCRX Build plugin In case "Inter-module” is specified in Compiler/Optimize/Ad: d) ion for access to external variables, "make.exe" process continues to run after build process is finished
The GDB Python library is missing from the RH850 GDB executable.
3960 Application As a work around the 'gdb' library from "\gdb\python\iib\" within a GDB source drop can be placed in DebugCompl\Lib\.
The properties dialog for Image element in Visual Expressions view accepted a minus (-) sign in edit fields which are Hex, Octal and Binary number-formats.
4007 Visual Expressions plugin Also when using Hex, Octal and Binary formats for number ranges, the ranges will be converted using long data-type rather than int data-type.
When building with GCC if the compiler command line options string exceeds 8192 characters it is truncated and may not work correctly.
4026 RX GCC build plugin If you encounter this issue - please try using a shorter path for the root of the workspace you are building.
When using Real-time Debugging, a memory value is acquired per byte.
4132 Real-time Watch Therefore in some cases the wrong value will be displayed if two or more bytes of a variable are displayed in real time.
4140 Application Performing a clean operation twice in succession for the CCRX toolchain performs a build and then a clean on the second clean operation.
4150 Project Generation Working sample debugger support is removed after updating the product version. To re-enable the WS support please copy the files back into the product from the original archive.
When érow5|ng Tor a toolchain In the add toolchain dialog in %oo céam Tmanagement if you USe the Context menu to paste the path into the dialog, the add button is not enapled.
4174 Application The workaround is to use shift + insert or Ctrl + v via the keyboard. This will enable the button.
When building a GNU RL78 project with more than 64K of code relocation truncated linker errors may occur.
Add additional linker section should be added ".lowtext". This section needs to contain the expression ".plt" and have a fixed address of 0xD8. The existing ".text" section should be
modified to follow on from this new section.
4219 Project Generation
RL78/L12 group of MCUs (RL78 family)
The setting of Key interrupt flag and Detection edge may not be saved. When saving the project after making the new setting and then reloading the project, the setting reverts to the
original setting as the new one had not been saved.
4223 Code Generator plugin After reloading the project, check that the setting of Key input interrupt is the same as the setting which was made before reloading.
RL78/G1A group of MCUs (RL78 family)
The Conversion time mode of the Conversion time setting may not be saved. When saving the project after making the new setting and then reloading the project, the setting reverts to
the original setting as the new one had not been saved.
4224 Code Generator plugin After reloading the project, check that the setting of Conversion time mode is the same as the setting which was made before reloading.




RL78/L13 group of MCUs (RL78 family)

When the timer KB20 is in use, the settings for Standalone mode (period controlled by external trigger input) and Interleave PFC (power factor correction) output mode may prevent
the correct output of the AP functions.

Make settings in Code Preview so that the following API functions are output manually.
- R_KB20_Create
- R_KB20_Start
- R_KB20_Stop
- R_KB20_Set_BatchOverwriteRequestOn
- R_KB20_TKBOONn_SmoothStartFunction_Start
- R_KB20_TKBOONn_SmoothStartFunction_Stop
- R_KB20_TKBOON_DitheringFunction_Start
- R_KB20_TKBOON_DitheringFunction_Stop
- R_KB20_TKBOONn_Forced_Output_Stop_Functionl_Start

4225 Code Generator plugin - R_KB20_TKBOONn_Forced_Output_Stop_Functionl_Stop
RL78/G10 group of MCUs (RL78 family)
When generating code corresponding to the gcc compiler, date information is outputted to the version comments box in the function header of the r_cg_reset_program.asm.
4226 Code Generator plugin
When "${workspace_loc}/FreeRTOS_ftpd_RSK_RX63N_rev100/src/ANSI" is specified in the include option, it is not able to be expanded in project explorer.
4246 Application ${WorkspaceDirPath} macro works well.
RX111 group of MCUs (RX family)
4251 Code Generator plugin When Code Generator is added to RX111 project, an extra node appears under Code Generator node at Project perspective tree. Nothing is performed at the node.
When using CCRX 2.x there have been issues with differences in the Elf/Dwarf output which needed to be resolved by the object converter in e2 studio.
4265 CCRX Build plugin If you had an error such as "warning: Code section size (0x11B) not a multiple of 4, this will now be resolved in 3.0.
4295 Application The position of the eventpoint within the source window is wrong in case it is defined via an offset (e.g. dummy_fkt 2+4 ...)
4304 Application Output file name cannot be changed in "Build Artifact" setting.
4330 Application Memory renderings are now persisted when a debug session is terminated and the associated debug configuration is re-launched.
When an error occurs after a program built, it has to be manually removed, otherwise this is kept in [Problems] even after multiple rebuilds.
The indexer picks up semantic errors in files OK and removes them when resolved. Linker errors are not being cleared. These need to be manually removed from the problems view
4332 Application after resolution.
4346 Application Projects can now be created with multi-byte characters such as those used in Japanese and Chinese character sets.
4352 Application Errors and warnings are now colored in the build console window.
GNU RX vector iali [e source Tle corrected. The Tollowing change was made to ensure interrupt handlers Work correctly:
//,0x0050 Reserved
(fp)O,
//;,0x0054 FCUERR
(fp)INT_Excep_FCU_FCUERR,
//,0x0058 Reserved
(fp)O,
//;,0x005C FRDYI
(fp)INT_Excep_FCU_FRDYI,
//,0x0060 Reserved
(fp)O,
4361 Application
4362 IAR plugins For the IAR toolchain. Although the "Generate debug information" is checked(Settings -> IAR RX Assembler -> Output) the --debug option is not passed to the iasmrx.
4369 Application Time stamp information added to the RX Trace output.
On e2studio v2.2.0.13 using GNURX v13.01 toolchain, when removing unused and unreferenced functions/variables with the "gc-sections" linker option, the ".rvectors' interrupt vector
section is deleted.
4372 Application The KEEP option is now set by default to avoid this problem.
4378 HEW Project Converter When importing some projects from HEW into e2 studio using the project import facility some source files were not included automatically.
4395 Application A new page has been added to the build preferences to allow custom tools to be added to the build. This is similar to the functionality offered by HEW custom phases.
Due to a mismatch between the user manual and the generated iodefine.h, some registers with smart manual cannot be searched and found.
4399 Smart Manual plugin
4411 Application The rx_converter.exe can crash when a CCRX output file is converted that was created using the global optimization option.
4413 Event points plugin Data access eventpoints are not persisted when e2 studio is closed and re-opened.
4430 Code Generator plugin For certain devices a Pin View has been added to the code generator to show pin settings visually.
It is now possible to change the device that the project is selected for after the project has been created. This is especially useful for changing the memory usage view and also the
smart manual.
4459 Application Go to project properties >> C/C++ Build >> Device.
4460 CCRX Build plugin When a library project is rebuilt the project that includes it does not re-link when it is also built.
4462 CCRX Build plugin The scan dependency tool should not be passing WIN32 when scanning the embedded source code.
4470 Application RX debugging, the ID code cannot be written even if it is downloaded with Flash Write mode.
4477 Application Projects with linked resources are not getting built after import using the HEW project import feature.
RL78 10 Access with multiple access widths read incorrectly. Work-around: Within your debug session,
from the 10 Registers view, 'All Registers' tab, add the registers you want to monitor to the 'Selected Registers' tab.
Do not add 1 byte width registers that belong to a 2 byte register, add the 2 byte register only.
Save the selected registers locally to an .xml file.
Disconnect the debug session.
On the Debug configurations dialog, Debugger->Debug Tool Settings, set 10->Use Default 10 Filename to 'No'.
In 10 Filename select the file you saved above.
Apply and debug.
4485 GDB server The 2 byte register values should now be shown correctly.
4488 Application Real-time Refresh of the registered expression does not become effective on the Expressions View. (Only Japanese-language edition)
_faris displayed as a syntax error in the editor when using GNU RL78.
After importing the project (created in v3.0.0.11 or previous versions) user has to go to 'Project > Properties > C / C++ General > Pre-processor Include Paths, Macros, etc. >
Providers' tab, and check the 'GNU Toolchain Built-in Language Settings [Shared]' checkbox. After selecting the mentioned check-box the __far keyword support will be added to the
4491 RL78 GCC build plugin imported project.
4504 Application In the Memory and Memory Browser views, the contents of memory near an end address is not displayed correctly.
The “iodefine.h" and “iodefine_ext.h" which generated as e2 studio RL78 GNU “executable” project have insufficient register definitions.
Missing definitions in iodefine.h:
P7, PM7, FLARS, FLWL, MONSTAO, ASIM, ...
Missing definitions in iodefine_ext.h:
4505 Project Generation PU7, PIM5, GDIDIS, BPALO, BECTL, FLSEC, ...
4509 Integration Server The e2 studio integration service has been updated to allow C# applications to use it.
4514 Application Conditional includes and compilation does not work correctly when local options are set on a source file.
When debugging with RX, the state of a debugger can become unstable éy ‘execution of a walt instruction.
4531 Application When a wait instruction is executed, "Remote failure reply: E31" will be displayed on the console (gdb) and the debugger will be disconnected.




4578 CCRX Build plugin

When using the CCRX toolchain there is a build error when setting options on a single source file for Compiler > CPU > Fast Interrupt register.

4582 Application The port added by an USB to serial converter is not displayed in the selection dialog in the RX debug configuration dialog.
4602 CCRX Build plugin Scan dependencies tool uses __ GNUC__macro automatically when building with RXC toolchain. It should only be used when using the GCC toolchains.
4616 CCRX Build plugin The clean build operation can fail when there are many hundreds of object files to clean.
4617 Application When the data of word size is written in a word size register, a upper byte and a lower byte are reversed.
4618 Application In the memory view when the data of word size is written in a word size register, a upper byte and a lower byte are reversed.
4620 Application In the memory view, when a fill operation is performed for a memory range the last 1 byte is not filled.
When using CCRX 1.x and GCC toolchains when putting a breakpoint on an invalid line a dialog 1s displayed saying the breakpoint will be placed at the next available instruction. A
yellow warning icon appears in the original location and a new "relocated breakpoint" icon appears where GDB placed the breakpoint.
4627 Application With CCRX 2.0 this does not happen.
4629 Project Generation When a new CCRX project is created the section top address will be modified from 0x0 to 0x4 as the new default option.
4694 Application User can not toggle method breakpoint then toggle line breakpoint at the line of an method name.
4730 Application Pre-build step gets invoked in between during project build.
4772 Application GCC build can fail when there are resources with spaces in their name.
When using CCRX with MISRA warning messages. Some problems are not shown correctly in the problems window. The error messages are shown correctly in the CDT console
window but they are corrupted in the problems window.
e.g. Instead of this format:
.\srcfilename.c(5):M0523028:Rule 2.2: Source code shall only use /* . . . */ style comments.
4781 Application Only the text "style comments" is displayed.
When using the IAR RX toolchain it is possible to see the following warning.
“warning: Loadable section "ROM32 ro" outside of ELF segments"
4794 GDB This warning may affect the correct loading of the binary into memory. Additional conversion is required to avoid this issue.
Project build fails for workspaces having special characters. Such as $ or #.
There are sitill limitations for certain characters in 3.0:
In any of the below cases project build fails:
1. If the filename contains % symbol (e.g. test%file.c)
4795 Application 2. If the workspace name contains A£ symbol (e.g. workspace)
4835 Application Projects that have linked resource files have these files imported as broken links while importing using the ‘copy project into workspace' option.
4843 CCRX Build plugin When using the CCRX toolchain the scan dependencies tool is not passed the *__RXV1"and "__RXV2" macros.
Linked resources do not get resolved on exporting the project as "File system/Archive File".
4864 Application Users will need to manually resolve the error by specifying the header file path present physically on the file system.
‘Custom Tools' does not work correctly when the ‘Inter-module’ is specified at the ‘Optimization for access to external variables' of compiler option.
4900 Application
In 2.2 the pre-build commands were not executed as pre-build but after the other phases were executed. Now the pre-build commands are executed before the build commences
4960 RX GCC build plugin some previous commands that assumed object files were available will now fail.
4971 Application Build artifact modified in CCRX project is not persisted after conversion to GNURX. The build artifact will need to be manually modified following the CCRX to GCC conversion.
4973 Application Pre-build and post-build steps are not persisted after conversion from CCRX projects to GNURX projects.

Open issues in 3.0.0.22

1D Component Description
Code Generator can delete user code between /* Start */ End comments in some situations.
Using the code generator if the following code is placed in the main function:
Jlif(data_in!=OXAA)
on a line by itself, all of the main code will be removed when Generate Code button is pressed.
5041 Code Generator plugin The key issue is that the { brace is on the same line as the comment.
5026 Application CCRX to GNU RX Project conversion: In Linker Section, Section names contain '$' symbol need to be removed manually.
When using the CCRX toolchain, variables placed at address 0x0000 are displayed as "no debug info" in GDB and variable type is lost.
5021 Application For variable type unsigned char (section B_1) and unsigned short (section B_2).
When initially creating a debug only project the extension of the specified module is not added to the debug configuration dialog. This means the file cannot be found when launched.
5016 Application Adding the extension back manually rectifies the problem.
5014 Application CCRX to GNURX conversion: Custom tool added in CCRX project is not available in the converted GNURX project.
5004 Application CCRX to GNU RX_Convertor: Local file options are not mapped for assembler files.
4990 Application The open Renesas Tool Settings-> C/C++ General, click on "Formatter" option. An exception is thrown.
4988 Visual Expressions plugin The state of the Visual Expressions view is not saved when you press the X and close the view.
4976 CCRX Build plugin When using the SHC compiler. Selecting "Absolute (SYSROF)" in [Linker][Output][Type of output file] does not work correctly.
‘ar' utility fails if the input is greater than 8191 characters. The command line options are truncated after every 8192nd character.
4975 RX GCC build plugin We will have to implement subcommand file (using '@") for ‘ar' utility similar to compiler and assembler.
Parallel build is not enabled after conversion from CCRX project to GNURX project.
4972 Application This can be switched on in the build configuration after conversion.
When source file is modified while debugging and the module rebuilt is downloaded via the 'module has changed' dialog.
4948 Application The module downloads correctly, the target is reset, but the e2 studio user interface does not show that PC has changed until a step is done.
A "Exception occurred during launch" message is displayed
4940 Application approximately 30 seconds after connecting to a target when using Hot Plug and using an image file.
In the Trace Acquisition dialog for the Renesas RX simulator,
4939 Trace plugin The Trace Output field is not necessary. it cannot be modified.
When debugging with RX, if the project is built by CCRX V.1.02, an error is displayed when getting the coverage data. If the project uses the CCRX V.2.01 toolchain, the error is not
4906 Coverage plugin displayed
Results in the coverage plugin do not relate to the actual program execution in some circumstances.
Lines show as not covered when assembly instructions were executed.
4899 Coverage plugin When the code is optimized this situation gets worse.
4892 Application When using GNU SH, selecting file properties for .s / .src file throws exception.
4881 CCRX Build plugin When using CCRX if there are certain characters in the build path such as $ in the workspace name it can cause the build to fail.
4876 Application When debugging with RX, if the settings are in flash write mode, the debugger features should be disabled.
4869 Application The "Memory" view always opened on launch of a debug session. It should not be re-opened on launch if it has been closed in the previous debug session.
GDB considers PUSHC instruction to be part of the function prologue and it skips it.
Inserting a break point at *function name
instead of function name solves the problem. (* tells GDB to start at the actual beginning of the function without skipping the prologue).
4857 GDB
4833 Application The clean functionality executes every time irrespective of whether the object file is present or not.
4826 CDT CDT global build console is empty after Build All.
4825 Application "Build selected file" does not work correctly when the assembler source file is selected.
4819 CCRX Build plugin Individual compile is not execute when Level2 is specified at the "Perform inter-module optimization".
4813 HEW Project Converter The simultaneous build setting is not setup when the project is imported from HEW. Please visit the C/C++ Build preferences and select the Behaviour tab.

4783 Performance Analysis

The option to Reset timer before each run, which is setup on the "Performance Analysis" dialog box is not reflected for RL78.

The specification for RL78 is that the values are reset all of the time so the option has no meaning.




A symbol address is not changed correctly at registering an Event Point for "Trace Start" and "Trace Stop" eventpoints with RL78.
The right address is displayed in the Select Symbol dialog.

4698 GDB However it is changed into the wrong value when shown in the Eventpoints view.
4665 Profile plugin When a single address is specified as the filter for the profile plugin it does not work correctly. The addresses matching the filter are not displayed in the view.
4640 Application When a program is compiled by inter-module optimization with the CCRX toolchain, the disassembly view cannot always display the disassembly instructions mixed with source code.
4634 Application The "Log scale” check box in the real-time chart properties does not work. Setting the box as checked and clicking OK will reset it to 0.
When sub menu "Add Watchpoint" is performed from a Memory view, it seems to have been registered correctly in the Breakpoints view even if there is an error condition.
4607 Event points plugin An error occurs by "Add Watchpoint”, when the maximum number of events was exceeded, or when a ROM area is specified.
4597 Application In some cases when a before PC eventpoint is set just after a break point, the program execution will not stop at the address the eventpoint is located at.
All configuration changes are not saved on changing multiple configuration settings in one session for GCC tools. Specifically this is referring to multiple settings changes across
multiple configurations and the clicking apply.
4579 RX GCC build plugin
There is a problem in e2 studio that the .cproject file can be modified even when the settings for the project were not changed. This can be seen by entering the settings dialog and
clicking apply directly after project creation.
In addition there are issues in generic Eclipse in this area.
4550 Application For option comparison, comparing the makefile is the easiest way to ensure the project settings are identical.
When debugging with RX there are problems with setting breakpoints when the hardware breakpoint resources have been exhausted and the software breakpoint setting also fails.
In this case the breakpoint appears to be valid but the debugger will not stop.
4548 Application This can often be seen when the option "Program re-writes internal Program ROM" is set to yes. As this means software breakpoints cannot be set.
4538 Static Analysis plugin The static analysis plugin cannot jump to the source location of a specified static function.
When building projects with CCRX that are in deep directory structures it is possible to experience build issues. e2 studio is unable to build projects which create command lines
4515 CCRX Build plugin reater than 8191 characters.
4492 Application The Module View of e2 studio does not display any information when an executable which includes debug information was downloaded to the target.
4450 Application Linker section settings of Renesas toolchain are not getting saved for multiple configurations.
For GCC RL78 there 15 a option Select Addiional CFSU Options™ in the project generator with the Tollowing Options:
: None
: Use Emulation for multiplication
: Use RL78 native multiply for G14
: Use RL78 hardware multiply for G13
However, there are more device families which support the native or hardware multiply:
RL78 native multiply: F13, F14, G14
RL78 hardware multiply: D1A, F12, G12, G13, G1E, I1A, L12, L13
Emulation for multiplication ONLY: G10
4445 Application The user interface should be updated to better reflect the situation for the RL78 devices.
When debugging a project that has been imported but that has not been rebuilt you need to setup the debugger to look in the original source file location.
4422 Application This is done via the Source tab of the Debug Configurations dialog.
4397 Application If the .*linker files in a project are read-only and the linker map is modified then no error is displayed or logged. But the changes are not saved.
When importing a project from CubeSuite+ to e2 studio the "toolchain version is changed" dialog is always displayed.
This is because the version string in imported project file and the toolchain information in e2 studio does not match. Ignoring this dialog and continuing should result in a successful
4350 Application import.
4314 GDB Server SH For the SH debugger the Debug Tool Settings -> Use User Stack option is not processed by the debugger. The setting is not used.
The current e2 studio build restricts the file types that can be used as input files.
For example assembler input files only supports the following:
.sfc
.SRC
4312 Application .Src
When the project has a toolchain that does not match the path for the toolchain installed on the machine problems with build can occur.
Workaround is to delete the 'org.eclipse.cdt.core.prefs' file from .settings folder and then import the project.
4303 RL78 GCC build plugin Alternatively you can modify the toolchain path from Properties > C/C++ Build > Environment. Modifying the toolchain path builds the project st
4300 Real-time Watch Modifying the name of a variable in the Expressions window may cause a prompt asking if the new variable should be made real-time aware (even if the old one was not)
4280 Integration Server The GetExpressionsS function in the Integration Server will in some cases return an invalid string. Workaround is to use the ReadMemory call to get the raw data.
Itis not permitted to use the tool chain editor on the Settings pages to attempt a conversion from GCC to CCRX or CCRX to GCC. This conversion is not permitted and may stop your
4213 RX GCC build plugin project working correctly.
When using Segger JLink, with the "Force Hardware Breakpoints" debug option enabled, adding more than the maximum amount of breakpoints for a device and then removing some
4191 GDB server RX can lead to none of the breakpoints firing. Workaround is to add a single breakpoint back in to trigger the reapply of all others.
4189 Application It is not possible to build project which has more than 98 characters in its project name.
The Renesas CCRX toolchain fails to build projects with the following conditions:
a. Project name with multi-byte characters
b. Project located in a path with multi-byte character
4176 CCRX Build plugin c. Project contains file with multi-byte character
FPU option is not set correctly for GNURX (RX200/RX100) executable project. "Disable generation of RX hardware FPU instructions” option should be checked and grayed out for
4129 Project Generation RX200 and RX100. However this option is not checked and is not grayed out.
4116 Profile plugin The loaded profile results in Profile View are shown on the right-hand side even when the View Loaded Data menu item is NOT selected.
4105 Application When using GCC on Japanese Windows. If you create a new workspace on the desktop the default GCC projects fail to build correctly.
When the project is re-named. If the user then uses the feature project > Build Configurations > Build All. The active configuration builds successfully but subsequent configurations
4104 Application fail.
After running a debug session with coverage on the whole file then a number of green indicators are displayed in the editor view as expected.
Close e2studio and restart.
The green indicators still remain even though there is no connection, coverage is disabled and no coverage address ranges or file specified in the Coverage View.
4056 Coverage plugin The only way to clear the file coverage indicators is to right click in the middle gutter and select "Clear Coverage Markers".
3992 Application When importing projects from HEW into e2 studio when the files are read only, build errors occur following import. Ensure the files are writable.
Breakpoints cannot be unset within the editor when code is #ifdef out.
3950 Application These breakpoints will need to be removed from the breakpoints plugin.




When importing a HEW project if it contains folders with the same name at the same hierarchy then not all the files will import successfully.

ie.

\WorkSpace\WorkSpace\Developments\src\embOS\UtI\MEASUREMENT.c"

Work \WorkSpace\Developmer p falUtil.c"

3945 Application
3932 Application If e2 studio is installed into the desktop folder or the workspace is within the "My documents" area on Japanese operating systems, the object converter can fail to execute correctly.
By default the e2 studio editor character code is set to UTF-8. This means it is possible to enter characters that are then not supported by default by the CCRX toolchain.
CCRX default input is SJIS.
To enable UTF-8 for the toolchain you must first select C99 support.
3928 CCRX Build plugin
When the current configuration is set to a custom configuration created by the user. The configuration following an export and import into another workspace is not restored correctly.
3867 Application It is restored to HardwareDebug.
3847 Application When using the display as array feature in the expressions window it appears that data can be skipped and is not updated.
38: Application Dependencies with file name that have spaces may cause dependency scanning issues. Where possible it is better to avoid using spaces in dependency file names.
38. Event points plugin 'Delete All'is enabled in eventpoints window even when there is no eventpoints.
38 GDB server RL78 Trace Record Eventpoints not working for IECube.
38 Event points plugin OA event break event points not breaking at correct addresses on SH7203 (External Flash) target.
380: GDB server RX When using 2 RX simulator debug configurations in parallel the debugger does not work correctly. Stepping and breaking does not work well.
The code generator is not automatically registered when installing into generic Eclipse. Browse to the CG plugin and then run the batch files that reside in the tools directory.
eg.
3804 Application C:\Renesas\e2_studio\eclipse\plugins\com.renesas.cg_1.0.0.201309061659\CodeGenerato\Tools
Creating a new trace file for E20 trace data takes a long time to complete due obtaining disassembly data for all the available records.
3798 Trace plugin During this period of obtaining disassembly data the debugger controls can become unresponsive.
3797 Trace plugin Creating a new save file to save data will not display the job in the foreground. Overwriting an existing trace file will show the progress dialog in the foreground.
3795 Trace plugin Saving RX Simulator trace data to the disk can take some time due to the number of records obtained from the server.
Trace Start and Stop eventpoints not being sent down to target in time.
3754 Application Making event point changes and then executing can result in them being missed the first time. To avoid this you can use the "Apply to Target" toolbar button in the eventpoints window.
With 2 targets connected, clicking between the two debug contexts in the Debug View will update the source addresses in the open Editor files.
3663 Application However changing debug context does not seem to get detected if clicking on the top-level of the debug context rather than on the lower level.
3657 Application If e2 studio is installed into a directory where any segment of the file path contains a space then the memory map plugin information cannot be retrieved for any target.
3626 Application Snapshot trace - adding 10 register eventpoints increases the data shown in the trace view, but as they were removed there was no change in the data shown.
3625 Application When using the Snapshot trace feature the data mask settings are not applied correctly.
3585 Application The GDB server crashes when an E1 emulator is connected to a debug configuration configured for the Segger emulator.
3550 Application Custom placeholders are not expanded when importing a project from HEW. This is currently expected behaviour but may be improved in a future version.
3526 Application In some cases when using RX with the CCRX compiler the profile view does not display the source file name and path in the window.
If a data type of a variable already displayed in the expressions view is updated, e.g. from char to long, after a re-build the expression view data type is not updated. However the data
value is correct.
3490 Real-time Watch Closing the debugger or e2studio does not clear the issue but clean does.
When changing the PC value in the registers window the PC display is not modified in the e2 studio editor. This is just a visual refresh issue. Stepping causes the views to update and
472 Application step occurs from the new location.
470 Application When debugging with the RX210 the FPSW register is displayed on the register view. This should not be the case as the RX210 does not have the FPSW register.
447 Application Using the copy register functionality in the register window sometimes copies the incorrect register information to the clipboard.
430 Application Select all in the registers window does not work correctly. It only selects the visible registers. This is an issue in standard Eclipse Juno.
'Execute The User Program After Ending The Debugger' should not be enabled when the target is powered internally.
3412 Application This can cause the debugger to hang.
SH2-70865A - clicking step-in when on the closing brace of a function will cause the server to run, but never respond again.
3410 GDB Server SH The only option is to terminate.
When debugging files with the same name show source addresses even though it may not be correct for the file in question. The full file path is not considered just the filename and
3389 Application current debug context. This can lead to e2 studio showing unr i
The address of pointer type variable can not be modified in Expressions View. e.g.
typedef int* PI;
Pls_pi = &glb;
In this case, address value of s_pi can not be modified in Expressions View.
3160 Application
3077 Application When using the RX Simulator. The "Failed to execute Ml command:" error appears intermittently when stepping with RX simulator and showing local variables.
Real-time refresh will not update visually for a complete structure.
3054 Application The workaround is to monitor individual members of the structure.
When exporting a project that has external linked folders rather than files which are resident in a source directory they lose their directory structure in the exported archive. When
3039 Application importing back into e2 studio the files specified as the original relative path are then not found. This is a standard Eclipse issue and is the current specification.
2948 GDB server Trace is not returning any records on first run from PowerON_Reset to main() with Segger J-Link.
2934 GDB server When using Performance Timer ints with RX Sil ints must be manually applied from the Eventpoints view before resuming.
2910 GDB Registers do not display properly on SH2A 72691.
2881 GDB Step over and step return do not work on SH2 70865.
2859 IAR plugins When using IAR projects the SFR names (e.g. PIOR1_bit.no1) are not understood correctly in the editor.
2762 Application When using assembly code within a C source file, Codan errors can be observed in the editor. Even though the project builds successfully.
2739 Application e2studio editor typing profiles will be changed so that spaces are used instead of the Tab character to generate Renesas target device source code.
2735 Trace plugin When using an IECUBE emulator saving large trace buffers can fail to complete.
2716 GDB server RL78 |Before PC events on IECube temporarily hard coded limit of 4.
2696 Application RL78 cannot step over empty for loop.
HEW Importer, output file(.P/.PP) is not generated while building the project.
2693 Application Workaround : User will need to select Settings -> Compiler -> Object -> outpui file type -> Pre-processed source file -> OK after importing the project and then build the project.
In e2studio for an application created by RL78 GNU compiler is the corresponding source code of RESET vector seem to be not found first and therefore a file with the info text 'No
source available for "(gdb[12].proc[42000].threadGroupli1],gdb[12].proc[42000].0Sthread[1]).thread[1].frame[0]" ' is displayed.
2671 GDB server Debugging can continue normally after this.
2667 GDB When using a big endian target, areas of memory not covered by the download module are considered little endian. This causes problems when viewing disassembly and memory.
When importing a configuration from another project when building a "File not found" exception is shown when the user tries to import external linker file.
2657 Application Creating the file inside the project directory should solve this issue.
2651 Application Library Template : Build fails when spaces are present for file or folder name.
2636 Application Visiting build options and clicking on 'OK' rebuilds already built GNUSH executable/library c/c++ project.




Set beyond this limit will return an error and the GUI displays a yellow warning triangle.

2544 GDB However press resume (F8) and no existing BP's work and cannot suspend, just terminate.
For the G13 IEcube it supports one run/break timer. Currently e2 studio is setting the support to 3.
2537 Performance Analysis
2486 Profile plugin Acquiring profile results can take a very long time following RX Simulator debugging.
Use of duplicate register is allowed for RXC project generation.
1. Create RXC project
2. Go to RXC Global option page, select "ROM" -> "R8"
3. Select the same value for any other register (e.g. "RAM" -> "R8"), it gives error message and prevents the user from project creation.
2416 Project Generation 4. Now select "R8" again for "RAM" register. It doesn't show any error message and allows user to create the project.
2390 RX GCC build plugin Exception is generated when all sections are removed from Linker Ul.
It is possible for .c and .C files to be treated in the same manner in certain situations which is not correct.
2299 RX GCC build plugin (.C extension is changed to .c during project build).
2193 GDB Server SH Reload of code for SH devices with external flash does not work. Instead, disconnect and reconnect.
Software breakpoints are not supported on targets that use external flash to run application.
Also, in this case ‘force Hardware Breakpoints'(In Debug tool settings) set to ‘No' by default.
2161 Application A warning message should be displayed while trying to set software breakpoints in such cases.
2156 Application When using the profile window, for SH72643, the ‘execution time’ and ‘average execution time shows negative values for the first time only after which it runs normally.
2081 Application After building a project if user changes anything in linker subcommand file option, only ObjCopy is gets invoked. Linker should get invoked.
Linker Section Editor - Need to conditional Enable / Disable the Ul buttons.
'Add button' is not disabled when user selects contents (Label, Expression or Keyword) inside the section.
2059 RX GCC build plugin When user clicks on add button, when Label, Keyword or expression is selected, nothing gets added.
Source/Disassembly not being displayed after trace view is opened.
2044 Trace plugin Toggle off and on the Source Mode button and source is now displayed and view continues to behave correctly there on.
HEW Project Import fails to build file due to File or path name too long.
This is due to the difference between HEW and Eclipse. In HEW object files are output to the configuration directory. In Eclipse the files are output alongside the source file in the
2010 HEW Project Converter same directory.
1982 RX GCC build plugin For Renesas CCRX the Converter phase gets invoked even when using the external linker subcommand option. This should not happen.
This results in the following error message "The selected .hwp file overlaps the location of another project”. See attached dialog.
This is because when the project is removed from the project tree the Eclipse projects are not physically removed. Deleting the Eclipse project files from the directory allows the
operation to continue.
1950 HEW Project Converter
1936 Coverage plugin When using the IECUBE for RL78 the source lines for coverage are not being highlighted correctly in some cases.
Trace Record execution address eventpoints are allowed with e2Studio, these are not available with HEW, should only allow Trace Record eventpoints of type data access to make
1927 Event points plugin consistent with HEW.
1904 Profile plugin Profile view: Go to source throws an exception if no file path is defined in profiler.
When an RX hardware debug session is executing the reset button can be operated but does nothing.
1891 Application In RL78 the debugger is reset correctly.
Due to file extension issue with .s and .S and due to known bug, e2studio users wont be able to use .s or .S effectively to pre-process assembly files that need GCC. Hence we
suggest renaming these files to use:
.S ->.asm
1889 Application .S -> .src
Program execution stops inside a range when Range Exclusive is specified in the address settings for OA event points.
1859 GDB server
HEW Importer: Compiler > Warnings > Advance > Enable All check-box is not mapped.
1846 HEW Project Converter All warnings checkboxes are checked as expected, however the 'Enable All' option is not checked.
1841 HEW Project Converter Importing HEW project generates warning in e2studio for 'src' directory.
Import a HEW RX project in e2studio using the HEW project importer.
1808 HEW Project Converter Check : Project > Properties > Compiler > Source > Include file directories. Paths are duplicated
While source mode is enabled on the trace view if you swap or cycle to another view, before returning to the trace view. The contents of the view will be removed. To obtain the source
view again please follow these steps:
1807 Trace plugin Enable Bus mode on the trace view, disable source mode on the trace view, re-enable source mode and then disable Bus mode.
Debug configuration button does not show last configuration.
The tooltip shows "Debug RX630E"
but when the button is pressed
1801 Application "RX62T" is launched, and "RX62T" is the one at the head of the list also.
1790 Real-time Watch Real-time expression settings are not saved when the application exits.
When setting the 'Internal Flash Memory Overwrite' debug option, it is possible to exceed the maximum number of non-continuous memory blocks supported. No warning is given if this|
limit is exceeded.
1778 Application When setting this option ensure the limit (16 for RX devices) is not exceeded.
When the project has been selected to use SH. The user is prompted to select the launch configuration on clicking ‘run’. The launch confi ion should be i selected
1742 Debug Configuration correctly.
For the SH7216 target (and most likely other targets), when using the address conditions and associated mask, the boolean parameter (parameter 17) ‘address mask compare type' is
1645 Event points plugin not being set to true.
Erase flash on start-up option on RL78 should be executed once.
1642 Application When e2studio connects successfully to RL78 target and erases the flash, this option should return to false, so that flashing is not done every time target is connected.
1640 Application After creation a project cannot be deleted straight away. If the user waits around 30 seconds the project can then be deleted.
1616 RX GCC build plugin The options of a Build Configuration were not correct after specifying Multiple Configurations... functionality.
1595 Application Renaming a project using the right click menu in the project explorer causes its respective debug configuration to
The edited value in Registers window was not highlighted when modifying the value in the registers window. The edited value should be yellow highlighted.
1532 Application Note: This appears to work for the first edited register okay following a target suspend. However any subsequent modifications are not highlighted.
The edited value in Expressions window is not highlighted.
The expressions are not updated in SR1 in the following circumstances:
1. When editing in-place within the expressions window.
2. Modifying the value of the expressions in the memory window.
3. When the target suspends and the views refresh.
1531 Application In each of these cases any expressions with modified values should be highlighted in yellow.




1523 HEW Project Converter HEW import page is displayed even when user tries to import normal project (other than HEW project).
1486 Application rBreakpoint properties do not work when set in the CDT dialogs. For example using the filter operation and removing the breakpoint for the process being debugged.
1485 Application The edited address value in Memory window does not highlighted in red but does update.
1460 Application Project builds, but rx_convertor.exe fails when on network drive.
1352 Application GNU Linker section : Deleting section using delete button (keyboard) does not work.
RX200 CPU selection should not be supported for toolchains =< 1.00.01 for the CCRX Renesas toolchain.
1263 Application This toolchain does not support RX200
Build console arrows (Next and previous ) does not work as expected.
1065 Application On selecting ‘Next' arrow, the listed errors are not scanned/visited through.
87 Application Exporting project if linker sections are modified and not saved generates an error. Resource not synchronized is the message.
35 GDB server RL78 G14-2 only allows one Event Break eventpoint
34 Event points plugin Eventpoints view toolbar label not updating for RL78 eventpoints.
30 GDB server Unlimited number of Event Break eventpoints allowed on RL78 devices
09 Application Selecting “Inhibit all warning messages" does not disable advanced warnings.
87 Trace plugin Trace address filter end range value gets set to the start range after reopening dialog.
79 Trace plugin Find and filter are greyed out after closing trace view. The only way to activate find and filter options is to resume debugging and suspend.
877 Debug Configuration 10View is populated for the incorrect target for debug-only projects. If you open the debug configuration dialog the IOView is populated with the correct target information.
Execution Address Eventpoints with trigger count do not work with Breakpoints on Segger RX.
Setting an execution address eventpoint with a trigger count on Segger JLink RX62N is not possible if any breakpoints exist, including the default at main.
If an execution address eventpoint with a trigger count is set with a breakpoint both the eventpoint & the breakpoint do not function. Multiple breakpoints are set then only 1 does not
874 Event points plugin work. Additional eventpoints function as normal.
873 Debug Configuration No Renesas GDB hardware launch shortcut for IAR & Green Hills plugins. Launch shortcut needs manual creation.
820 GDB server Address mask not working for RL78. Program execution does not stop, expecting to see program execution stopping every time we access an address ending in e8.
816 GDB server Data Access mask not working for address values for RL78. Program execution stops each time the address is accessed no matter what value it contains.
811 GDB server Trigger Count not supported for RL78 but is still available in the Eventpoint View.
803 GDB server RL78 program execution stopping on 'Equal' when 'Not Equal' is specified in the Compare Settings.
The trace plugin data field if find & filter is set does not remember its value. When reopened the data option has both fields populated with a numerical number not entered by the
789 Trace plugin user.
785 Trace plugin Bus mode records sometimes fail to update if rapid cycling through the available trace modes.
Using Find on “Address" allows the entry of a case insensitive hex number. However on "Destination Address" a case sensitive string is required. This needs to be made clearer on the
722 Trace plugin Ul
When instruction stepping into code, PC is sometimes not correctly placed.
628 Application When this happens the home button does not restore the PC location correctly. Clicking the current stack frame in the Renesas debug view does remedy the issue.
567 Real-time Chart Itis not possible to edit series name in the real-time chart view.
When entering address, compare and mask values for an eventpoint, hex digits are assumed. The dialog should assume field values are decimal unless prefixed by a modifier such as
549 Application "Ox" for hex. This is for consistency with data entry and presentation throughout Eclipse/CDT.
When the refresh interval is <120 msecs the Real-time views are not updating.
First observed in Real-time Expressions, but will probably affect Chart and Memory too.
540 GDB server Increasing the refresh interval to 200 msecs is a workaround.
525 GDB server When Move to Line is used with RX targets the program is resumed from the selected line, the expected behaviour is that the program would remain suspended.
Browse (...) remaining disabled on Eventpoints view.
Open the Eventpoints view. Double click on the Event Break eventpoint category. Select OR in the Trigger combo box. Click Add on the Edit Trace dialog. Click on the ... button
alongside the Address text control.
482 Event points plugin A dialog should appear with a list of address labels but the ... button remains disabled
480 Event points plugin Unable to add eventpoints using the insert key.
478 Event points plugin Clicking on column headers in Eventpoints view does not order entries.
475 GDB server RL78 Once a debug session has been terminated when using an IECUBE another connection is not possible until the IECUBE had been unplugged from the machine.
Trace view - save and load trace data. When trace data is saved the save dialog defaults to .xml extension rather than .rtt. This means that the saved data is not loaded back into the
view.
Also the load dialog defaults to .xml, but does not load the trace data back into the trace view regardless of the file type. lllegal trace files are not flagged as non standard trace files as
452 Trace plugin per requirements.
When using the project generators some settings are not remembered correctly when moving forward in the wizard and then stepping back.
The 'CPU Type' information is not saved, while some of the additional options are remembered and some not.
419 Project Generation
In case of MinGW toolchain projects - Whenever you add any include path in the compiler / assembler include path option, it is displayed in the Project Explorer -> <prj_name> ->
Includes.
In case of KPIT / Renesas toolchain projects - Whenever you add any include path in compiler / assembler include path option, it is not displayed in the Project Explorer -> <prj_name>
-> Includes.
364 Application
301 Trace plugin Trace buffer full functionality needs addition. New checkbox needs adding to the GUI.
e2-server-gdb executable currently causes a security alert in Windows when executed for the first time. The publisher is currently undefined also. Accepting the dialog allows normal
220 GDB server operation to proceed.
72 10 view plugin All 1O registers for RX devices are listed as Read/Write? in the 10 xml files used by the 10 view, even though some are read or write only.
40 ication The "Error: Unable to create variable object" is sometimes shown during debugging when stepping out of functions.
There are some 10 Registers where the same memory address holds 2 registers with difference access sizes. These registers are general a read-only register and another register
used for writing which is write-only.
These registers are currently all listed as R/W in the 10 Map file and so the view will attempt to display values for the wrote-only registers. When it does this the bytes are displayed
17 10 view plugin reversed.




